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1. Contents of Installed Package 
 

A. Stormwise_Distribution – executable programs and example data files 
 

1. BMPFIT –  
a. AMPL run, model, and data files to implement multipoint cost calibration to obtain 
StormWISE parameter HALF_COST_PER_AREA. This is a console program.  At the 
command prompt, type  

ampl xxx.run  
where “xxx” stands for a land use category,  

for example:  
ampl commercial.run  
to display results for commercial land use category to the screen.   

BMP performance and cost data can be changed by editing the file xxx.dat for each 
different land use category. 

b. BMPFIT.xls – a template file for Microsoft Excel which, when used with the Excel 
“solver” add-in, will perform a multi-point cost calibration to obtain StormWISE 
parameter HALF_COST_PER_AREA and also plot the results. 
 
UNITS used in the BMPFIT data files:   
Design_Rainfall - inches 
Area_Served - acres 
Cost_Coefficient - $/square foot 
Cost_Exponent - dimensionless - lower for BMP's with site-scale economies of scale. 
L, U - fraction of subwatershed pollutant load typically removed by the BMP technology for 
this LANDUSE 
  (L = lower limit, U = upper limit, set L = U for initial analysis and then try U > L) 

 
2. GWLF_postprocessor – a console program to read comma separated value (.csv) files 
containing output from the AVGWLF pollutant load simulation model (sediment, nitrogen, 
and phosphorous loadings) and generate an input (.inp) file for use by StormWISE.  
AVGWLF .csv files containing summary data have the form  

PROJECT-XXXXsum.csv 
where  PROJECT is the name of the AVGWLF project and 
XXXX is a code for the drainage area generated by AVGWLF.   

After generating such an output file for each of the subwatershed drainage areas in your 
analysis, copy them into your StormWISE project folder and at the command prompt, type 
 gwlf_postprocessor  PROJECT XXX1 XXX2 XXX3 … 
where XXXx names each of the different drainage areas to include in the StormWISE 
analysis.  An example of the use of this program is provided in the StormWISE_Examples 
folder in the StormWISE directory, and is described further below.  NOTE: the file BMP.inp 
must be present in the same directory when running GWLF_postprocessor, which contains a 
protion of the StormWISE .inp file related to BMP technologies and costs.  BMP.inp can be 
edited to change cost and performance assumptions for BMP technologies.  The source code 
for GWLF_postprocessor in the “C” programming language, and it can be recompiled from 
the provided source code to run on almost any computing system.  Also, this program can be 



modified by users with C programming experience to parse the output files of other nonpoint 
pollution loading simulation programs. 
 
3. npsopt_washoff – a console program with similar capabilities to the StormWISE 
graphical interface program.  It can read StormWISE .inp files generated manually, by 
GWLF_postprocessor, and also by the StormWISE graphical interface program, described 
below.  An example from Swarthmore College’s Springfield project is provided in this 
folder.  The “.inp” files contain pollutant loading and cost data.  The output is an AMPL 
“.dat” file that is read by the optimization module in file npsopt_washoff.mod.  The sequence 
of commands is as follows: 
 Notepad PROJECT.inp  
to create or edit a StormWISE input file,  
where 

“PROJECT” is the name of the current project, which is usually the name of the 
larger watershed being analyzed.   

 
 Example:     Notepad Springfield.inp 
 

After exiting notepad, type: 
npsopt_washoff  PROJECT   POLLUTANT   REDUCTION  

where: POLLUTANT = the name of a specific pollutant as specified in the PROJECT.inp 
file 

 REDUCTION = the amount of pollutant reduction desired (in the same units used 
in the “.inp” file for pollutant loadings, such as Tons for sediment or pounds for 
nutrients) 

 
Running “npsopt_washoff” will generate the file PROJECT.dat. 
 
Example:   npsopt_washoff  springfield  TSS-TON  50  

  will generate the file “springfield.dat”, and AMPL optimizer input file. 
 
 Now, type the command: 

 
ampl   PROJECT.run   

 
 Example:  ampl Springfield.run 
 

Note: the ampl program is included in the example folder.  If extensive use is made of the 
command line programs, users should download the full ampl  program from 
http://www.ampl.com and install it in a location that appears in the computer’s “Path” 
environment variable. 

 
The file PROJECT.run must be edited to contain the name of the correct data file, 
PROJECT.dat.    The AMPL output, containing optimal investment levels by land use 
category and subwatershed drainage area, is displayed to the screen by default.  Output can 
be redirected to a file as follows: 
  ampl PROJECT.run > PROJECT.txt.  
This file can be opened by Notepad and printed, if desired, or copied and pasted into a word 
processing document. 

http://www.ampl.com/�


4. StormWISEis a graphical user interface program containing all of the functionality of 
npsopt_washoff with an easy-to-use interface and display results on a pie chart showing 
optimal stormwater investments by subwatershed drainage areas.  Editing of StormWISE 
data input (“.inp”) files can be accomplished using data grid tables similar to a database or 
spreadsheet program.  A data grid table also displays optimization model results.  The user 
can easily modify assumptions and data such as the amount of pollutant reduction desired.  
This is done by entering a value in the “Desired Reduction” column in the upper right corner 
of the StormWISE window. (Note: “Desired Reduction” must be less than the amount 
indicated for “Maximum Reduction”) Typically the user will generate a sequence of results, 
each for a different level of pollutant load reduction, and the cost implications of each 
selection will be displayed.  The pie chart can be configured to display results for a single 
land use category or any combination of land uses categories. 
 
BEFORE INSTALLING STORMWISE.  StormWISE graphical interface requires that 
Microsoft “DotNET 2.0” (or greater) be installed on the users computer.  The DotNet 
modules may already be installed to support other software installed on the computer. If not, 
download the Microsoft .NET Framework Version 2.0 (or greater) from the Microsoft.com 
web site and install it.     
 
INSTALLING STORMWISE.  The StormWISE installer is downloaded in the form of a 
compressed “.zip” file.  Extract the contents of this file and run the file “setup.exe”.  This 
will invoke the StormWISE installer program that runs under Microsoft Windows Installer.  
You will have the option of specifying where StormWISE program files should be stored on 
your computer.  The installer will automatically create a “StormWISE” folder in your “My 
Documents” folder containing at a minimum the “Empty Project” and 
“StormWISE_Documentation” folders.  You will also be able to choose whether or not to 
install the following additional components in the “StormWISE” folder:  (1) “Auxiliary 
Command Line Programs” (BMPFit, GWLF_Postprocessor, and NpsOpt_washoff), (2) 
“Sample_Projects” (Springfield and Tacony), and (3) StormWISE source code. 
 
STORMWISE EXAMPLES.  Start the StormWISE program using either the StormWISE 
entry on the Start/All Programs menu or the program icon on the Desktop.  If the installation 
was successful, you will be greeted by a splash screen showing the StormWISE owl and the 
main screen, shown below.  An array of menu options and tool bar shortcuts is provided 
along the top.  Using File/Select Input (.INP) File, or clicking on the "Select Input (.INP) 
File" tool allows the user to navigate to the location of a StormWISE input file with the 
".inp" extension containing the data required to run the model.  Note that this file can also be 
created and edited using an ASCII text editor such as Windows Notepad. 
 
Springfield Example.  The Springfield example is ready to run.  From the File menu, choose 
"Select Input (.INP) File.  A window pops up allowing you to navigate to My 
Documents\StormWISE\Sample_Projects\Springfield\Input_Data_Tables.  Select 
“Springfield.inp” and click “Open”.  View the data in the tables, if you like, and then click 
“OK”.  Enter pollutant reductions in the “Desired Reduction” column (eg. 50 tons of TSS-
TON which is sediment).  From the Analyze menu, select “Run”.  The output table should 
fill with numeric results and a pie diagram should appear.  Now, you may print the results by 
selecting “Print” from the “File” menu.  More details on the StormWISE menus and toolbars 
are provided in the Tacony example, below. 

 



 

 
StormWISE main screen 

 
 

  Tacony Example.  The example from Tacony Creek in northeaset Philadelphia 
demonstrates how a user can start from a basic pollutant loading analysis using the 
AVGWLF model (from Pennsylvania State University:  http://www.avgwlf.psu.edu/.  The 
three drainage analysis from the “Tacony” example is shown below.  Separate analyses were 
run for three subwatershed areas numbered 9654, 9664, and 9802 in the AVGWLF 
Pennsylvania database.  The output text files in comma separated value (csv) format were 
copied from the AVGWLF output directories for each analysis and are installed by the 
StormWISE installer in:  
My Documents\StormWISE\Sample_Projects\Tacony\AVGWLF_Postprocessor_&_Example.   
 
 
Tacony GIS shapefile generated by AVGWLF.   The GIS shape files generated by ArcVIEW 
while running the example in AVGWLF are installed in the GIS_ShapeFiles subfolder of the 
Tacony folder.  Any ShapeFiles generated by ESRI ArcView can be viewed by ESRI ArcView 
or ArcGIS software and also by free software such as MapWindow 
(http://www.mapwindow.org/) which is also used by USEPA's BASINS software package.   The 
user can use these shapefiles to generate a GIS display of the results generated by StormWISE. 
 
 

 
Generating a StormWISE Input File from multiple AVGWLF Output Files.  Continuing 
with the Tacony example, “.csv” files from an AVGWLF analysis of three subwatershed 
drainage areas (labeled 9654, 9664 and 9808) are supplied in the folder.  These are used with 

http://www.avgwlf.psu.edu/�


GWLF_postprocessor to automatically generate an input file for StormWISE.  Also, 
“gwlf_postprocessor” expects to find a file “BMP.inp” provided by the StormWISE user 
containing data on BMP performance and cost parameters.  You can open the provided file 
with a text editor to view or edit the values used in this example.   
 
To generate the StormWISE input data file, open up a command prompt (console) window 
and navigate to the Tacony folder.  Enter: 
 
 gwlf_postprocessor tacony 9654 9664 9802 
 
This will generate a file called “tacony.inp” which can be loaded by StormWISE using the 
menu sequence “FILE/Select INP file” (or by clicking on the select INP tool) and navigating 
to the Tacony folder.  Note that the input data for BMP's is not contained in AVGWLF 
output.  Also, it is necessary to provide a mapping between the landuse categories used in 
AVGWLF and those used in StormWISE.  Thus, gwlf_postprocessor expects a separate input 
file called "BMP.inp" is to be in the same folder with the ".csv" files containing sections 
dealing with the landuse mapping, BMP treatment fractions, half costs, and removal 
efficiencies.  An example BMP.inp file is provided and it can easily be edited. The data 
editing screen below appears: 

 

 
 
The tabs on this screen show the four different model components of all StormWISE 
projects:  Sets, 1DTables, 2DTables, and 3DTables.  There are three different sets, 
LANDUSE, DRAINAGE, and POLLUTANT.  LANDUSE contains the names of the 
landuse categories used in the current project.  DRAINAGE contains the names of the 
subwatershed drainage areas, which are 9654, 9664, and 9802 in this case.  POLLUTANT 
contains the names of the pollutants to be included in the analysis, in this case SEDIMENT, 
TOT_N (total nitrogen) and TOT_P (total phosphorous). 

 
Clicking on the 1DTables tab shows subtabs for the two one-dimensional tables which contain 
numeric entries for the “TREATMENT_FRACTION” and the “HALF_COST_PER_AREA,” as 



shown below.  The first is the fraction of the runoff that is captured by the water quality BMP, 
typically 90%.  The second is the BMP cost per acre of drained area for each managed land use 
category.  This “marginal cost” increases with the fraction of the entire acreage treated.  The 
HALF_COST_PER_AREA is the marginal cost at the point where half of the acreage in a 
particular land use category is managed by BMP’s.  Estimates of this cost parameter may be 
estimated from site-specific BMP cost data using the BMPFIT program, described earlier.  
Alternatively, to obtain a "first-cut" estimate of watershed-wide BMP costs the user may 
estimate the HALF_COST_PER_AREA using the marginal cost of a single

 

 BMP technology 
that would most likely be deployed to reduce runoff and pollutant loadings for each landuse 
category, as shown in Equation (5) of the 2006 StormWISE Report to EPA (included with the 
StormWISE installation). 

 
 
Clicking on the 2DTables tab shows subtabs for two two-dimensional tables which contain 
numeric entries for BMP_EFFICIENCY, as a fraction, by pollutant and land use category, 
and DRAINAGE_LANDUSE_AREA, which shows the land area, typically in acres, for each 
drainage area (as columns) and each land use category (as rows).  Note that to exclude a 
particular land use category from consideration for BMP installation, simply enter zero for 
the BMP_EFFICIENCY, as shown in the Tacony example, below. 



 
 
Finally, clicking on the 3DTables tab shows a single three-dimensional table for 
POLLUTANT_LOAD having a layer for each pollutant, and a two-dimensional table 
showing loadings, in appropriate pollutant loading units (such as Tons for sediment and 
Pounds for nutrients).  The loadings, in Tons, for Sediment in the Tacony example are shown 
below.  Note that when a particular land use does not exist in a subwatershed drainage area, a 
“*” character indicates that the loading value is not possible. 

 

 
 
 
 



All data fields can easily be changed by simply editing the numeric fields.  But the user 
should NOT edit any of the name fields in this format.  Changes to name fields must be made 
by clicking on the “Sets” tab, selecting the Set to be edited, and then clicking the “Add” 
button to create an additional landuse, drainage area, or pollutant, or by highlighting one of 
the existing names and clicking the “Remove” button to eliminate it from the model (be sure 
to highlight a name before clicking “Remove”).  If a set name is added, then numeric data 
must be entered in all tables where that name appears in a row or a column. 
 
If all data fields are valid, then clicking the “OK” button in the lower right corner of the edit 
view will update the model with the data and return to the main screen, as shown below. 
 

 
 
Two new tables have been added to the display: an empty table in the lower area which is 
prepared to receive the output of the optimization module, and a partially filled table in the 
upper right corner.  This table invites the user to enter the pollutant reduction that is desired 
for the first run of the optimization screening model.  If the model is run without editing this 
table, no pollutant reduction will occur, and no cost will be incurred.  The maximum possible 
reduction is displayed.  Always specify a desired reduction less than the maximum reduction.  
Entering any value larger than the maximum will result in zero output. 

 
The screen below shows the result when the user requests a reduction of 5 tons annually of 
sediment over the entire study area (i.e. from all three drainage areas).  After entering a value of 
5 in the “Desired Reduction” column, the user selects the menu option “Analyze/Run” or simply 
clicks the Run tool.  The table now shows how much sediment reduction to pursue by installing 
BMP’s in each of the three drainage areas.  The optimal investment levels (in $1000 units) to 
direct towards each drainage area are shown as well as the amounts of pollutant removal 
achieved by that investment.  Note that although the user made no request regarding the amount 



of TOT_N and TOT_P to reduce, some reductions in these pollutants are achieved anyway 
because BMP’s that remove sediment also typically remove nutrients.  Also, note that the total 
cost of achieving these pollutant reductions is estimated to be $50,000 and that most of it should 
be directed towards projects in drainage area 9664 and no projects should be pursued in drainage 
area 9654, if overall cost minimization is the only objective influencing the decision.  In reality, 
the decisions regarding where to place BMP’s depend on multi-objective considerations such as 
flood control, and other practical considerations.  Thus, model results can not be interpreted 
strictly.   On the other hand, these results can help watershed managers approach the very 
difficult problem of prioritizing projects in a way that achieves the greatest pollutant reduction 
for a certain level of investment.  Another way of stating this result is that the model predicts that 
any alternative BMP investment strategy in this subwatershed would result in either a cost higher 
than $50,000 to achieve the same 5 tons annually of sediment removal, or sediment removal of 
less than 5 tons for the same investment of $50,000. 
 

 

 



Note that the solution above yields very little of the potential 102 pounds annually of 
phosphorous removal.  If the user now enters the amount of 10 in the Desired Reduction 
column for TOTAL_P, and runs the model again, the result is shown below. 
 

 
 
More investments in BMP technology are required, both in subwatershed 9664 and 9802.  
Also, the amounts of SEDIMENT and TOT_N removed also increase because the BMP’s 
installed to remove phosphorous also typically remove sediment and nitrogen. 
 
At this point, the user can save the model data in data file having the same or a different 
name.  Also, the Pie Chart and the data tables can be printed out using the File/Print menu.  
Note that only limited support is provided for formatting the printed output.  Users may find 
it convenient to print to a PDF file for further formatting or to simply generate a screen shot 
of the StormWISE display on the clipboard using the Alt-PrtScr keystroke combination and 
then paste the image into a word processor. 
 
Land Use Category Display of Results.  In order to display the investment levels associated with 
a single land use category or groups of land use categories, use the “View” menu.  There you 
will find checkboxes that enable you to display results for only those land uses that you have 
selected.  Note that when different combinations of land use are chosen, only the cost numbers in 
the table will change, and the pollutant removal levels will continue to show totals for the entire 
watershed.   

 
Empty Project.  An empty input file, “empty.inp” is provided in the folder My 
Documents\StormWISE\Empty_Project.  If it is loaded, then the model data must be entered 
using the data grid table editing capabilities of StormWISE.  The resulting input table can 
then be saved for future use.  Data fields that have not yet been entered are indicated by the 



caret “^” character.  The entries on the “Sets” table should be configured first.  You can add 
or delete landuse categories, drainage areas, and pollutants modeled.  Then, using 1DTables, 
2DTables, and 3DTables, enter the required numerical values from data on your drainage 
areas and from the output of your pollutant load estimation model.  StormWISE will not 
allow the user to save the changes or to solve the model until all data fields containing “^” 
have been replaced with valid numeric data.  If you are unsure about reasonable estimates for 
some of the numeric values, enter a temporary numeric “place holder” value such as 99.99 so 
that you can save the file and continue editing later. 

 
Manual Editing of Data Input Files.  First-time users should open up one or more of the 
“.inp” files using a text editor, such as Notepad to view the format of this file.  It is very 
similar to the format of the data grid view tables in the graphical interface.  Users can 
manually edit these data fields, if desired.  The format of the “.inp” files is not rigid regarding 
delimiters (other than the semicolon and braces), capitalization, and white space.  However, 
please note that the semicolon “;” at the end of each block of data is mandatory.  Deleting a 
semicolon or failing to use one when manually generating a “.inp” file will lead to 
unpredictable results.  Also, all of the data components (sets, 1-d tables, 2-d tables, and the 3-
d table) must be present in the file, with the titles properly spelled. 
 



B. StormWISE Source Code 
 
Please Note: Distribution of source code from the StormWISE project is controlled by 
the Mozilla Public Software License Agreement, which users must accept before 
installing the software. 

 
The StormWISE installer gives the user the option of installing source code.  If this option is 
selected using the checkbox during installation, then source code folders will be installed in 
the “My Documents” folder.  Source code is provided for GWLF_PostProcessor, 
npsopt_washoff, npsoptclr, and StormWISE.  An additional folder, “corecode” contains C++ 
source code files that are common to both the command line and graphical versions of the 
software. 
 
GWLF_PostProcessor is self contained code written in standard C.  The source code files can 
be extracted and compiled by a C compiler on any computing system. 
 
“npsopt_washoff” is primarily a single “main.cpp” program written in standard C++.  It calls 
functions in the “corecode” folder.   
 
“corecode” contains modules “datablock.cpp” for structuring the input file data into blocks 
which are converted to sets, 1-D tables, 2-D tables, or 3-D tables by the “dataget.cpp” 
modules.  The data structures are defined and implemented in “datacomponent.cpp”.  Finally, 
“npsopt.cpp” provides routines for editing and assuring consistency of all data blocks.  The 
core code is all written in standard C++, and it makes extensive use of the extremely efficient 
standard template library.  It can also be compiled on any computing system supporting a 
C++ compiler, and can be made functional using “npsopt_washoff” or another program 
written by future developers. 
 
“npsoptclr” provides an interface for the core modules to the Microsoft “.NET” common 
language runtime (CLR) environment.  It is written using Microsoft’s “managed extensions” 
of the C++ language which enable easy access to C++ code by other managed languages, 
including C# (C-sharp), Visual Basic, and J# (Microsoft’s implementation of the Java 
language).  Microsoft’s Visual C++ 2008 software is used to compile these modules. 
“npsoptclr” functions as a “wrapper” for the core code modules to enable them to interact 
with “.NET” managed code.  Its output is a dynamic link library file, “NpsOptClr.dll” which 
must be present for the StormWISE program to function. 
 
Finally, the StormWISE folder contains the code for the graphical interface.  These modules 
are written in Microsoft Visual Basic and are compiled by Microsoft Visual Basic 2008, 
which is included along with Visual C++ 2008 in the suite Visual Studio 2008.    The base of 
software developers with Visual Basic experience is quite large, so the prospects are good 
that this code can be used beyond the scope of the current project through distribution in the 
open source community. 

 


